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본 소프트웨어는 바이올린, 비올라, 첼로의 헤드 디자인을 위한 프로그램입니다. 현악기 헤드는 설계 원리가
매우 복잡하여 컴퍼스와 자만으로는 정밀하게 작도하기 어렵습니다. 특히 기본 원리를 유지하면서 형태를
세밀하게 수정하는 작업은 더욱 까다롭기 때문에, 수작업만으로 완성도 높은 헤드 디자인을 구현하는

것은 사실상 불가능에 가깝습니다.

본 소프트웨어는, 불연속점의 존재와 디자인 작업의 어려움 등 기존의 헤드 디자인 방식의 한계와 불편함을 해소하기
위해 개발되었습니다. 제작자는 자신만의 독창적인 모델을 설계하거나, 기존 모델을 정밀하게 카피하고 변형하는
데 이 프로그램을 활용할 수 있습니다. 특히 기존 모델을 카피할 때 단순히 사진 윤곽선을 따는 것이 아니라 수학적
모델을 기반으로 곡선을 생성하므로, 완벽하게 매끄러운 곡선을 얻을 수 있습니다.

스크롤 디자인에는 수정된 로그 나선을 사용하며, 펙박스 디자인에는 클로소이드 곡선을 적용합니다. 몇 가지 파라미터
조절만으로 원하는 곡선 형태를 자유롭게 만들 수 있으며, 헤드 디자인 시 반드시 지켜야 하는 규칙을 실수로 어기지
않도록 돕는 안전장치도 포함되어 있습니다.

비올라와 첼로를 위한 턱 디자인도 완벽히 구현할 수 있으며, 악기별 프리셋을 제공하여 작업이 빠르고 편리합니다.
완성된 디자인은 범용 캐드파일로 저장되어 작업용 템플릿 제작에 활용할 수 있고, 함께 생성되는 텍스트 파일에는
상세 데이터가 기록되어 디자인 분석에 유용합니다. 또한 가져오기/내보내기 기능으로 이전에 작업한 디자인을 즉시
불러와 실행할 수 있습니다.
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1 본 소프트웨어의 기능

1.1 디자인

• 수정 로그 나선과 멀티클로소이드 곡선을 이용한 자동 디자인
• 결과 디자인의 표시 항목(레이어) 선택
• 결과 디자인의 갱신 방법 선택
• 참고용 악기 이미지 표시 기능
• 설정값의 가져오기와 내보내기
• 악기별 초기값 제공(프리셋)

1.2 출력

• 결과 디자인의 화면 출력
• 결과 디자인의 PDF 파일 출력
• 결과 디자인의 DXF 파일 출력
• 결과 디자인 수치값의 TXT 파일 출력

1.3 분석

• 디자인에 사용된 파라미터값 표시
• 각 부위별 수치값 표시
• 각 부위별 비례값 표시

H.I.S. Violin Atelier, Manual, April 2026 Page 2 of 34



Violin Head Designer, v.1.0.0 User Manual

2 인스톨

본 소프트웨어는 포터블 버전이므로 별도의 설치 작업은 필요없습니다. 압축을 풀고 《Violin_Head_Designer_v.X.X.X.exe》
파일을 더블 클릭하면 바로 프로그램이 실행됩니다. 단, 컴퓨터의 사양에 따라 실행에 시간이 오래 걸리는 경우가
있습니다.

프로그램 실행시에는 다음과 같은 점에 주의하여야 합니다.

■ 관리자 권한으로 실행

《Violin_Head_Designer_v.X.X.X》 폴더가 C드라이브의 《Program Files》 등 윈도우의 시스템 폴더 안에 있는 경우에는
프로그램 실행시 반드시 [관리자 권한으로 실행]하여야 합니다. 그렇지 않은 경우 제대로 동작하지 않거나, PDF, DXF,

TXT 파일 등이 정상적으로 저장되지 않을 수 있습니다.

■ 윈도우 보안 설정

프로그램 파일의 압축을 풀때 《윈도우 보안》에서 의심스러운 파일 등의 이유로 자동으로 일부 파일을 삭제하는 경우가
있습니다. 그 경우에는 윈도우 보안 설정에서 해당 파일을 격리 해제 시킨 후 다시 압축을 풀어서 사용해야 합니다.
본 소프트웨어는 어떠한 바이러스도 포함하고 있지 않습니다.
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3 프로그램의 동작 원리

3.1 제어점과 참고점

본 프로그램은 제어점을 기준으로 곡선을 생성하거나 참고점의 위치를 결정합니다. 제어점은 총 4개(점 O, S, T, Z)
이며, 사용자가 직접 좌표를 입력합니다. 지판 끝지점(점 O)은 원점(0, 0)으로 설정되며, 스크롤의 눈 중심(점 S)은
스크롤과 펙박스 등 모든 곡선 디자인의 시작점이 됩니다. 또한 펙박스 테일 끝점(점 T)과 넥의 가장 얇은 지점(점 Z)
이 제어점으로 사용됩니다.

참고점은 위의 4개 제어점 외의 점들을 의미하며, 제어점의 위치와 다양한 파라미터 설정에 따라 위치가 결정됩니다.
참고점은 다른 점과의 거리나 각도 등을 통해 정의되고 입력됩니다.

스크롤 디자인에는 로그 나선과 멀티클로소이드 곡선이 사용되며, 펙박스에는 멀티클로소이드 곡선이 사용됩니다.
다양한 스크롤 형태를 구현하기 위해 로그 나선은 기본 수식을 변형하여 적용했습니다. 멀티클로소이드 곡선은 3

개의 클로소이드 곡선을 G2 에르미트 보간법(G2 Hermite lnterpolation)을 사용하여 하나로 매끄럽게 연결한 곡선입니다.

Figure 1: 제어점(적색점)과 참고점(그 외 색상)
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3.2 로그 나선

로그 나선(Logarithmic Spiral)이란 극점(중심점)에서 뻗은 반직선과 나선이 만나는 각도가 어디서나 일정한 나선입
니다. 이 일정한 각도 때문에 나선을 따라 이동할수록 극점으로부터의 거리가 등비적으로 늘어납니다. 즉 한 바퀴 돌
때마다 반지름이 일정한 비율로 커집니다. 자연계에서는 앵무조개의 단면이 대표적인 예입니다.

(a)로그 나선 (b)앵무조개의 단면

Figure 2: 로그 나선과 앵무조개

수학적으로는 다음과 같이 표현되며, 바이올린 스크롤의 기본적인 형태라고 볼 수 있습니다.x(θ) = a · ekθ cos θ

y(θ) = a · ekθ sin θ
(1)

a: 초기 반지름 (θ=0 일 때의 반직선의 길이)

θ: 회전각 (라디안)

k : 나선의 팽창률 (양수면 바깥으로, 음수면 안으로)

하지만 실제 바이올린 스크롤은 표준 로그 나선과 다소 차이가 있습니다. 따라서 실물에 더 가까운 곡선을 구현하려면
기존 수식을 수정해야 합니다. 다음 장에서는 본 프로그램에서 사용하는 변형 로그 나선에 대해 설명합니다.
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3.3 변형 로그 나선

본 프로그램은 다양한 바이올린 스크롤 형태에 대응하기 위해 로그 나선 수식을 변형하여 사용합니다. 다음 식과 같이
표준 로그 나선 수식의 지수(k)를 α, β, γ, δ로 세분화하여, 여러 가지 형태의 나선 곡선을 정교하게 구현합니다.x(θ) = a · eα θβ+γ θ+δ θ2 cos θ

y(θ) = a · eα θβ+γ θ+δ θ2 sin θ
(2)

a: 초기 반지름 (θ=0 일 때의 반직선의 길이)

θ: 회전각 (라디안)

α : 지수 계수 (curvature)

β : 지수 승수 (change rate)

γ : 선형 보정항 계수

δ : 2차 보정항 계수

아래 그림은 가장 안쪽의 첫 번째 스크롤과 가장 바깥쪽의 세 번째 스크롤 크기(반지름)는 고정하고, 두 번째 스크롤의
크기만 변경한 모습입니다. 그림에서 A, B, C는 유지되고 D만 변경된 것을 확인할 수 있습니다.

Figure 3: 변형 로그 나선으로 그린 두 곡선의 비교)

변형 로그 나선의 모양은 4가지 파라미터(α, β, γ, δ)에 의해 결정되지만, 사용자가 이 값들을 직접 설정하기란 매우
어렵습니다. 따라서 사용자가 3개 스크롤의 반지름만 입력하면, 프로그램이 자동으로 최적의 파라미터를 찾아내어
곡선을 생성합니다.
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3.4 클로소이드 곡선

클로소이드 곡선이란 곡선 길이가 증가할수록 곡률이 커지는 곡선을 의미합니다. 즉, 곡선의 곡률 이 점점 커져서
갈수록 더 동그랗게 말려들어가는 모습의 곡선입니다. - Figure.4 (a) -

이러한 클로소이드 곡선은 일정한 속도로 달리는 자동차의 핸들을 일정한 속도로 회전시켰을 때 자동차가 이동하는
궤적과 일치하기 때문에 주로 고속도로의 커브 구간에 완화 곡선으로 주로 사용됩니다. Figure.4(b) 의 붉은 선이 클로
소이드 곡선입니다. 고속도로로 예를 들자면, 파란색의 직선 도로에서 녹색의 원형 도로로 들어가려할 때 클로소이드
곡선을 따라 점진적으로 회전 반경을 줄여나가는 것입니다.

(a)클로소이드 곡선 (b)고속 도로의 클로소이드 곡선

Figure 4: 클로소이드 곡선
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3.5 멀티클로소이드 곡선

고정된 위치의 두 제어점을 클로소이드 곡선으로 연결할 때, 두 제어점에서의 곡선 방향이 변하지 않는다면 그 두
제어점을 연결하는 클로소이드 곡선은 단 하나만 존재하게 됩니다. 이 문제는 바이올린 디자인시에는 큰 문제가
됩니다. 왜냐하면 악기의 사이즈가 같다면(제어점의 위치가 같다면) 단 하나의 디자인만 만들 수 있기 때문입니다.

Figure.5(a) 는 점 A 와 B 를 하나의 클로소이드 곡선이 연결하고 있는 모습니다. 이 곡선은 점 A 와 B 에서 곡선의
방향이 바뀌지 않는한 절대로 모양이 바뀌지 않습니다. Figure.5(b) 는 점 A 와 B 를 멀티클로소이드 곡선으로 연결한
것으로, 점 A 와 B 에서 곡선의 방향은 그대로 유지하면서 곡률만을 바꾼 것입니다. 그림에서 보듯, 무수히 많은
모양의 곡선을 생성할 수 있습니다. 즉, 멀티클로소이드 곡선을 이용하면 제어점의 위치와 곡선의 방향을 바꾸지
않고도 다양한 모양의 곡선을 생성할 수 있습니다.

(a)단일 클로소이드 곡선 (b)멀티클로소이드 곡선

Figure 5: 단일 클로소이드와 멀티클로소이드 곡선

본서에서 말하는 멀티클로소이드 곡선은, 《G2 에르미트 보간법》이라는 방법을 이용하여 3개의 단일 클로소이드
곡선을 이어붙여서 하나의 곡선으로 만든 것을 말합니다.
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3.6 멀티클로소이드의 모양 변경

어떤 두 개의 점이 멀티클로소이드 곡선으로 연결되어 있을 때, 그 곡선의 모양은 각 점에서의 멀티클로소이드 곡선의
《방향》과 《곡률》에 의해 결정됩니다.

■ 방향

곡선이 향하는 방향(각도, 동쪽=0◦)에 따라 곡선의 모양이 바뀝니다. Figure.6은 출발점과 도착점에서 방향이 다른
멀티클로소이드 곡선의 모양을 나타내고 있습니다. 좌측 그림은 272◦방향을 향해 출발하고 있으며 중앙 그림은 300◦

방향을 향해 출발하고 있습니다. 우측 그림은 도착점에서의 방향이 다른 경우입니다. 주의할 점은, 곡선의 방향은
항상 《진행 방향을 기준》으로 한다는 점입니다. 중앙 그림에서 도착점 B에서의 곡선의 방향은 231◦이며 우측 그림의
방향은 200◦입니다.

Figure 6: 곡선 방향 변화에 따른 멀티클로소이드 곡선의 모양 변화
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■ 곡률 (절대값의 크기와 부호)

곡률은 곡선의 휨 정도를 결정하는 값으로써 곡률(절대값)이 크면(=곡률 반경이 작으면) 급격하게 휘고, 작으면
완만하게 휘게 됩니다. 또한 +/- 부호는 휘는 방향을 결정합니다. 곡률의 부호가 + 일 때에는 진행 방향에 대해서
좌측으로 휘며, 부호가 - 일 때에는 우측으로 휘게 됩니다.

Figure.7 는 출발점 A에서 방향이 같고 곡률의 값(절대값)과 부호가 바뀔 때 곡선이 어떻게 변화하는지 보여줍니다.
좌측 그림은 곡률이 -100 일 때의 모습으로, 부호가 - 이므로 진행 방향에 대하여 우측으로 휘고, 곡률의 절대값이
크므로 급격하게 휘어 있습니다. 반면에 우측 그림은 곡률이 +100 일 때의 모습으로 부호가 + 이고 절대값이 크므로
진행 방향에 대하여 좌측으로 급격하게 휘어 있습니다. 가운데 그림은 곡률이 0 일 때의 모습으로 정해진 진행 방향에
대하여 휘어짐 없이 곧게 뻗어있음을 알 수 있습니다.

Figure 7: 곡률의 부호와 절대값 변화에 따른 멀티클로소이드 곡선의 모양 변화
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3.7 곡선의 이름과 위치

본 프로그램은 헤드에 사용된 곡선과 직선에 고유 명칭을 부여합니다. 명칭은 다음과 같으며, 레이어 패널에서도
동일하게 사용됩니다. (레이어 패널의 명칭은 볼드체로 표기)

대분류 중분류 소분류 구간 사용 곡선 설명

Scroll Curve
Scroll S1→S12

변형 로그 나선
점 S1(시작점)에서 S12(끝점)까지의 나선 곡선

Extended Scroll S12→
Scroll의 가상 연장 곡선이며, S12부터 반바퀴 회전.
Outer Lower와 비교하기 위한 참고선.

Inner Curve

Inner Upper S16→S19 원호

Inner Guide와 완전하게 겹치는 원호이며, 팩박스
전면부 곡선의 위쪽 방향 가상 연장선. Scroll의
위쪽으로 휘돌아 Scroll의 앞쪽에서 Scroll과 만난다.
팩박스의 평평한 수평면은 Scroll에 접어들면서 서서히
경사가 생기게 되는데 그 경사면과 수평면의
경계선이다.

Inner Lower

Inner Connector S16→S18

멀티클로소이드

Inner Connector와 Inner Bottom은 하나의 곡선
(멀티클로소이드)이며 개념적으로만 분리한 것. Inner

Connector는 Inner Lower의 시작 구간이며 Inner

Connector의 끝단은 Inner Hook의 끝단과 일치. (Inner

Bottom의 시작점에서 위쪽으로 Inner Connector와
Inner Hook로 분기)

Inner Hook S17→S18
Inner Bottom과 Scroll을 이어주는 연결 곡선으로
악기를 걸 때 사용되는 부위

Inner Bottom S18→Y
팩박스 전면부의 주된 곡선으로 Inner Connector의
아래 구간

Inner Base Y→C1 직선
Inner Lower 아래에 있는 직선 구간으로 이 직선
구간이 없는 악기도 있다.

Inner Guide •S, S-S16 원
Inner Upper와 Lower를 결정하기 위한 참고선이며,
Inner Curve는 Inner Guide 위의 점 S16에서 Upper와
Lower로 나누어진다.

Outer Curve

Outer Upper S12→S14 멀티클로소이드
Scroll의 최전면 지점(S12)에서 최후면 지점(S14)까지
상단부를 반바퀴 회전하는 곡선. 로그 나선인 Scroll과
달리 클로소이드 곡선으로 작성

Outer Lower S14→T 멀티클로소이드
팩박스의 후면부 곡선으로 Outer Upper에서 이어져
내려오는 곡선

Outer Guide S12→ 단일클로소이드
Outer Upper/Lower 곡선 작성시 참고하기 위한 순수한
단일 클로소이드 곡선

Table 1: 곡선의 이름과 설명
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Figure 8: 곡선의 이름과 위치
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4 화면 구성과 기능 설명

4.1 메인 윈도우

[메인 윈도우]는 총 5개의 구역으로 구분되며 각각 다음과 같은 역할을 합니다.

• Area (A): 도면 이름 설정, 프리셋 적용 버튼, 제어점과 참고점의 설명 이미지
• Area (B): 도면 작성을 위한 악기 사이즈 설정
• Area (C): 곡선의 모양 설정
• Area (D): 작성된 도면에 표시할 항목을 선택
• Area (E): 도면 그리기 및 파일 저장 버튼

Figure 9: 메인 윈도우
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4.1.1 기본 설정

■ MODEL NAME

작성하는 도면의 이름을 입력합니다. 여기에 입력된 문자는 [결과 윈도우] 및 저장되는 모든 파일에 기록됩니다.

■ PRESET

사용자 편의를 위해 제공되는 프리셋 기능은 원하는 악기 버튼을 클릭하면 모든 입력란에 초기값이 자동으로 채워집니
다. 입력된 값을 모두 지우려면 [Delete All Value] 버튼을 클릭합니다. 비올라는 턱(Chin)이 있는 모델과 없는 모델로
구분되어 있습니다. 프리셋 버튼으로 전체 값을 먼저 입력한 후, 필요한 부분만 수정하여 작업하는 것이 효율적입니다.

프리셋은 아래 모델들을 기반으로 설계되었습니다. 다만, 참고한 악기 사진의 왜곡 때문에 실제 악기의 치수와 완벽히
일치하지 않을 수 있습니다. 일반적으로 헤드 사진은 스크롤 중앙에 초점을 맞추어 촬영하므로, 초점에서 멀어질수록
왜곡이 심해집니다. 이로 인해 펙박스 하단부나 펙홀의 위치는 실제 모델과 다소 차이가 있을 수 있습니다. 원본
모델에 Head Margin이 없는 경우라도 프리셋에는 이를 모두 적용하였습니다.

※ PRESET의 악기 모델

• Violin: Stradivari, Violin, 1677.Sunrize

• Viola (chin X): Stradivari, Viola, 1734.Gibson

• Viola (chin O): Stradivari, Viola, 1672.Mahler

• Cello: Stradivari, Cello, 1732.Stuart

■ DIAGRAM

제어점과 참고점의 위치 및 입력 항목들이 가리키는 부위를 확인할 수 있습니다.
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4.1.2 사이즈 설정

■ GEOMETRY > Instrument

바이올린, 비올라, 첼로 중 설계할 악기를 선택합니다. 이 옵션은 [결과 윈도우]와 PDF 파일 그래프의 축 범위를
자동으로 설정하는 데 사용됩니다. 비올라는 턱(Chin) 디자인의 유무에 따라 두 가지 모델로 구분됩니다.

■ GEOMETRY > Set Axes

[결과 윈도우]에 표시될 가로와 세로 축의 범위를 설정합니다. [Auto]를 선택하면 악기 크기에 맞춰 축 범위가 자동으로
지정됩니다. 직접 설정하려면 [Use My Value]를 선택한 후 하단 입력란에 X축과 Y축의 최소·최대값을 입력하십시오.
단위는 [mm]입니다. 예를 들어 헤드의 세로 길이가 106mm라면, 전체 곡선이 잘리지 않도록 Y축 최소값은 0보다
작게, 최대값은 106보다 크게 설정해야 합니다.

■ GEOMETRY > Set Canvas Size

[결과 윈도우]의 캔버스 크기를 설정하며, 사용자의 모니터 해상도를 고려해야 합니다. 캔버스 사이즈 값 ’1’은 해상도
100dpi에 해당합니다. 예를 들어 모니터 해상도가 [1024 * 768]이라면 최대 캔버스 크기는 약 [10 * 7.7]까지 가능합니다.

설정 방식은 [Auto]와 [Use My Value] 중 선택할 수 있습니다. [Auto] 선택 시 가로 6, 세로 10으로 지정됩니다. 헤드의
가로세로 비율은 악기별로 큰 차이가 없으므로 [Auto] 설정을 권장하며, 모니터 해상도가 낮은 경우에만 수동으로
크기를 줄여 사용하시기 바랍니다.

■ GEOMETRY > Coordinate & Parameter

4개의 제어점(O, S, T, Z)과 각 부분의 치수를 입력하여 헤드의 전체적인 크기와 모양을 결정합니다. DIAGRAM

이미지를 참고하여 원하는 값을 입력하십시오. 제어점 중 원점(O)을 제외한 S, T, Z는 반드시 XY 좌표값을 입력해야
합니다. 이때 지판 끝점인 원점(0, 0)을 기준으로 한 상대 좌표값을 입력해야 함에 유의하십시오. (프리셋 기능을
이용해 값을 일괄 입력한 후 수정하면 더욱 편리합니다.)

• S - Position (x,y): 스크롤의 회전 중심점 S는 육안으로 정확한 위치를 파악하기 어렵습니다. 따라서 대략적인
위치를 먼저 지정한 후, 곡선을 설정하면서 미세하게 조정하여 최적의 위치를 찾아야 합니다.

• T - Position (x,y): 펙박스 끝점 T는 모서리 가공 전의 완전하게 뾰족한 가상의 지점을 의미합니다. 실제 악기에
서는 식별하기 어려우므로, 위아래 곡선이 교차할 것으로 예상되는 지점으로 설정한 뒤 곡선을 그리며 위치를
수정하십시오.

• Z - Position (x,y): 넥의 가장 얇은 지점이자 넥 커브가 끝나는 지점입니다. 프로그램이 이 점을 기준으로 넥
커브를 생성하므로 Z의 위치에 따라 넥커브가 바뀝니다.

• A. Eye Front: 스크롤 중심점에서 앞단까지의 거리입니다. 스크롤 앞단(점 S12)이 점 C1보다 앞으로 나오면
경고 메시지가 표시됩니다. 이는 지판 교체나 접합면 작업시 대패질로 인해 스크롤이 손상되는 것을 방지하기
위한 안전장치입니다.

H.I.S. Violin Atelier, Manual, April 2026 Page 15 of 34



Violin Head Designer, v.1.0.0 User Manual

• B. Eye Back: 스크롤 중심점에서 뒷단까지의 거리입니다. 고악기의 경우 스크롤의 뒷단은 마모가 심하므로
미리 고려할 필요가 있습니다.

• C. Head Margin: (또는 Fingerboard Margin), 지판 수리나 기울기 조정을 고려하여 적절한 값을 설정하는 것이
좋습니다.

• D. Bottom Margin: 팩박스의 직선 구간입니다, 팩박스 곡선의 휨 정도에 따라 이 구간의 길이를 조절할 필요가
있습니다.

• E/F. Nut ...: 너트의 크기와 형태가 디자인에 직접 영향을 주지는 않지만, 너트의 두께와 높이에 의한 원호는 펙
홀의 위치를 판단할 때 사용되므로 가급적 정확하게 입력하는 것이 좋습니다.

• G. Peg Hole Diameter: 펙 홀의 위치가 부적절하면 현이 펙박스 내벽에 닿을 수 있습니다. 이를 방지하기 위해
정확한 지름 값을 입력하십시오. 주로 두 번째 펙(H21)에 감긴 현이 내벽에 닿을 확률이 높으므로, 해당 부위의
최대 지름(팩박스 내부)을 측정하여 입력합니다.

• H. Peg Box Thickness: 현이 펙박스 내벽에 닿는지 미리 판단하기 위한 값입니다. 펙박스 후면은 플루팅(Fluting,

Dorso) 가공으로 인해 실제 두께가 입력값보다 얇아집니다. 바이올린의 경우 플루팅 깊이가 약 2-3mm이므로,
이 값은 최소 4mm 이상으로 설정할 것을 권장합니다.

• I. Upper Peg Margin: 최상단 펙의 중심점과 스크롤 최하단 사이의 Y축 거리입니다.
• J. Lower Peg Margin: 최하단 펙의 중심점과 지판 끝단(원점) 사이의 Y축 거리입니다.
• K:L:M. Spacing Ratio: 네 개 펙의 간격 비율입니다. 양 끝의 K와 M은 동일하게 설정하고, 중간의 L은 이보다

조금 더 크게 설정하는 것이 일반적입니다.
• N. Chin Margin: 첼로와 비올라의 턱(Chin)은 보통 지판 끝점에서 시작하지만, ’T’자형 너트를 가진 일부

비올라 모델(Stradivari, Viola, 1727, Cassavetti 등)은 ‘T’자형 너트를 가지고 있어 지판 끝점이 아닌 너트의 중간
지점에서 턱이 시작됩니다. 이러한 모델을 설계할 때는 적절한 값을 입력하고, 그 외에는 ’0’을 입력합니다.

• P. Chin Angle: 턱선의 기울기를 조정하고 싶은 경우 해당 각도를 입력합니다.
• Q. Chamfer Width: 모서리를 가공했을 때의 단면 폭입니다.
• R. Chamfer Radius: 설정한 [Q. Chamfer Width]를 얻기 위해 점 T에서 깎아내야 할 양을 자동으로 계산하여

보여줍니다. (직접 입력할 필요 없음)

1바이올린과 첼로는 현의 순서가 반대이므로 본 프로그램에서는 제일 위쪽에 있는 펙부터 순서대로 1,2,3,4번 펙으로 지칭합니다(H1,H2,H3,H4).
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4.1.3 곡선 설정

■ CURVES > Scroll (S1-S12)

본 프로그램에서 Scroll은 점 S1부터 S12까지 이어지는 나선을 의미합니다. [Coordinate & Parameter] 값을 입력한
후에는 Scroll의 모양을 가장 먼저 잡는 것이 좋습니다. Inner/Outer Curve가 모두 Scroll의 영향을 받기 때문입니다

• U. Eye Angle: Scroll의 시작점 S1이 이루는 각도를 입력합니다. Scroll 중심부에 위치하므로 전체적인 인상을
결정하는 매우 중요한 요소입니다.

Figure 10: 스크롤 눈의 각도

• 1/2/3◦ Scl. Radius (...): Scroll 내부의 세 가지 반지름을 입력합니다. Scroll 형태는 세 가지 파라미터와 [A.

Eye Front] 값에 의해 결정됩니다. 여러 파라미터를 사용하여 내부 곡선의 크기를 각각 조절할 수 있지만, 로그
나선의 특성상 각 반지름을 완전히 독립적으로 제어하는 데는 한계가 있습니다. 만약 나선 생성이 불가능한 값을
입력하면 경고 메시지가 표시되며, 입력값에 가장 가까운 형태의 곡선이 자동으로 생성됩니다. 이 과정에서
최적의 곡선을 찾기 위한 ’최적화 계산’이 진행되며, 연산에 수초 정도 소요될 수 있습니다.

Figure 11: Scroll을 위한 4개의 파라미터

H.I.S. Violin Atelier, Manual, April 2026 Page 17 of 34



Violin Head Designer, v.1.0.0 User Manual

• 1/2/3◦ Result: [결과 윈도우]에 표시되는 디자인의 실제 치수를 의미합니다. 일반적인 Scroll 형태라면 대부분
입력값과 동일한 결과를 얻을 수 있으나, 최적화 계산이 실패한 경우에는 입력값에 가장 가까운 곡선을 생성한
뒤 그 실제 치수를 이곳에 표시합니다.

(a)최적화가 성공한 경우 (b)최적화가 실패한 경우 (c)최적화가 실패한 경우의 경고메세지

Figure 12: 최적화 계산의 성공과 실패

■ CURVES > Inner Upper (S16-S19)

디자인 작업은 가급적 Scroll Curve > Outer Curve > Inner Curve 순으로 진행하는 것을 권장합니다.2 Inner Upper

곡선은 점 S16(시작점)에서 S19(끝점)까지 이어지는 원호이며, Inner Guide 원과 완전히 일치합니다. 원호는 시계
반대 방향으로 그려지므로 S16이 시작점이 됩니다. 이 곡선은 실제로는 드러나지 않는 가상의 곡선으로, Inner Lower

곡선을 따라 올라가다 Outer Upper 또는 Scroll 곡선과 만나는 지점(S19)에서 끝납니다.

펙박스의 수평면은 Scroll 영역에 가까워질수록 점차 기울어지며 경사면으로 변합니다. 이때 Inner Upper 곡선은
수평면과 경사면 사이의 경계선 역할을 합니다. 따라서 이 원호의 반지름이 크면 Outer Upper나 Scroll 곡선과 일찍
만나 S19의 위치가 올라가고, 반지름이 작으면 더 늦게 만나 S19의 위치가 내려갑니다.

Inner Upper의 원호 중심은 점 S이며, 반지름은 점 S와 S16 사이의 거리입니다. 따라서 Inner Upper의 형태는 S16

의 위치에 의해 결정되며, S16은 Inner Upper와 Lower를 잇는 연결점이 됩니다. 이 반지름이 작을수록(S와 S16이
가까울수록) 펙박스의 목 부분이 굵어지고, 반지름이 클수록 목 부분이 얇아집니다.

S16의 위치는 극좌표계로 지정하며, 점 S에서의 거리(V. Radius)와 수평선 기준 각도(W. Angle)로 정의합니다. S16

은 두 곡선의 연결점이므로, 이 지점에서 Inner Upper와 Lower의 곡률이 비슷해야 매끄럽게 연결됩니다. S16의 위치가
적절하지 않으면 Inner Lower의 설정을 아무리 변경해도 자연스러운 곡선을 얻기 어렵습니다. Inner Lower(멀티클
로소이드 곡선)가 Inner Upper(원호)로 이어지는 원리는 Figure.4(b)와 유사합니다. 직선 도로가 원형 도로로 진입할
때의 매끄러운 흐름을 상상하면 S16의 위치를 정하기가 더 쉽습니다.

대부분의 악기에서 S16은 점 S와 S14(Outer Curve의 정점이자 상하 곡선의 교점)를 잇는 직선의 중간 부근에 위치합
니다. 이 규칙을 활용하면 반지름과 각도를 한꺼번에 가늠할 수 있어, S16의 위치를 정하는 좋은 출발점이 됩니다.

2Outer Upper/Lower 곡선의 연결점인 S14의 위치가 Inner Curve에 영향을 줄 수 있기 때문입니다.
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Figure 13: Inner Upper의 역할과 점 S16의 위치 결정

• V. Radius: 점 S 와 S16 의 거리, Inner Upper와 Inner Guide의 반지름이 된다.
• W. Angle (S16): 점 S를 지나는 수평선에 대한 직선 SS16의 각도

※ Inner Upper에 사용되는 곡선의 종류에 대하여

본 프로그램은 Inner Upper 곡선에 원호(Circle)를, Inner Lower 곡선에는 클로소이드 곡선을 사용합니다. 일부 연구에
서는 원호 대신 스케일이 다른 두 개의 클로소이드 곡선을 서로 반대 방향으로 배치하여 설계하기도 합니다(이 경우
Inner Lower 중간 지점에서 두 곡선이 연결됨). 이처럼 Inner Upper에 클로소이드를 사용하면 곡선의 끝이 Scroll의 S8

또는 S9 지점과 만나게 됩니다.

반면 본 프로그램은 Inner Upper에 원호를 적용하므로, 곡선의 끝이 Outer Upper나 Scroll과 맞닿게 됩니다. 이 방식은
펙박스의 수평면과 Scroll 경사면 사이의 경계선을 명확히 정의할 수 있다는 장점이 있습니다. Inner Upper 곡선이
원호인지 클로소이드인지에 대한 논의는 이 선이 실제로는 보이지 않는 가상의 곡선이기 때문에 발생합니다. 하지만
펙박스 수평면과 Scroll 경사면의 경계를 설명하기에는 원호가 더 적절하다고 판단됩니다.

■ CURVES > Inner Lower (S16-Y)

Inner Lower 곡선은 S16에서 Y까지 이어지는 멀티클로소이드 곡선입니다. S16에서 두 곡선이 불연속점 없이 매끄럽게
연결되려면 방향과 곡률이 일치해야 합니다.3 원하는 형태를 얻기 위해 곡률은 조정할 수 있지만, 방향은 반드시
유지해야 합니다. 따라서 프로그램은 시작점의 방향을 S16에서의 원호 곡률을 기반으로 자동 설정하여 고정합니다.
또한 끝점 Y의 방향은 수직 아래인 270◦로 고정되어 있습니다. 사용자는 이 두 방향을 고정한 상태에서 시작점(S16)
과 끝점(Y)의 곡률만을 조절하여 곡선 모양을 만듭니다.

3실제 방향은 180◦ 반대 방향이 됩니다.
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만약 이 파라미터만으로 만족스러운 모양이 나오지 않는다면, Inner Base 값을 조절하거나 S16의 위치 자체를 변경해
보시기 바랍니다.

• Start Angle: 고정값(자동), 시작점 S16에서의 곡선(원호)의 방향(각도)+π
• Start Curvature: 시작점 S16에서의 곡률
• End Angle: 고정값, 270◦

• End Curvature: 끝점 Y에서의 곡률

※ Inner Guide 곡선
Inner Guide는 Inner Upper와 중심점 및 반지름이 동일한 원입니다. Inner Upper는 이 Inner Guide를 기준으로 작성됩
니다.

■ CURVES > Inner Hook (S17-S18)

Inner Hook는 Scroll과 Inner Lower를 연결하는 멀티클로소이드 곡선입니다. Scroll과 만나는 지점은 S17, Inner Lower

와 만나는 지점은 S18로 정의합니다.

Inner Lower는 개념적으로 S18 하단(Y까지)의 Inner Bottom과, S18 상단(S16까지)의 Inner Connector로 구분합니다.
Inner Connector는 실제로는 드러나지 않는 가상의 곡선이므로, 이를 명확히 분리하기 위해 명칭을 나누어 부릅니다.

S17의 기본 위치는 S3과 S7의 중간 높이이며, S18은 S11과 같은 높이에 위치합니다. 이 점들의 위치는 [ADJUST]
패널에서 세밀하게 조절할 수 있습니다.

Figure 14: 점 S17과 S18의 기본 위치

• Start Angle: 시작점의 방향
• Start Curvature: 시작점의 곡률
• End Angle: 끝점의 방향
• End Curvature: 끝점의 곡률

■ CURVES > Outer Guide (S12-Gb-)

Outer Guide는 단일 클로소이드 곡선으로, Outer Upper와 Outer Lower를 작성할 때 기준이나 참고용 곡선으로 활용됩
니다. 순수한 클로소이드 곡선이기에 형태가 매우 매끄러우며, 직접 작성한 Outer Curve를 이 곡선과 비교해 봄으로써
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현재의 Outer Curve 특징을 쉽게 파악할 수 있습니다.

Outer Guide의 끝점은 S12이며, 시작점은 S12의 Y축 선상에 위치합니다. 단일 클로소이드이므로 형태 자체는 바꿀 수
없고 크기(Scale)만 조정 가능합니다. 크기는 [A. Eye Front]와 [B. Eye Back] 값을 기반으로 자동 계산되며, 곡선에서
가장 뒤로 돌출된 지점을 Gb로 정의합니다.

점 Gb는 Outer Upper와 Outer Lower의 연결점인 S14의 기본 위치가 됩니다. Outer Upper의 경우, 시작점과 끝점의
곡률만 적절히 조절하면 Outer Guide와 완전히 일치하는 곡선을 얻을 수 있습니다.

• Clothoid Scale: 곡선의 크기값, 자동 계산

■ CURVES > Outer Upper (S12-S14)

Outer Upper는 Scroll의 가장 앞쪽(시작점 S12)과 헤드의 가장 뒤쪽(끝점 S14)을 잇는 멀티클로소이드 곡선입니다.
시작점 S12는 [A. Eye Front]와 Scroll 파라미터에 의해 결정되며, 끝점 S14는 Outer Guide의 Gb 지점을 기본값으로
사용합니다.4 별도의 조정을 하지 않는다면 S14와 Gb는 같은 위치에서 서로 겹치게 됩니다.

이 곡선의 시작점과 끝점 방향은 수직(90◦, 270◦)으로 고정되어 있어 곡률만 변경할 수 있습니다. 두 지점의 곡률을
조절하여 형태를 바꿀 수 있지만, S14의 위치가 고정되면 모양 변경에 한계가 있습니다. S14의 위치는 [ADJUST]
패널에서 상하로 조절하며, 좌우 이동은 [B. Eye Back] 값을 통해 설정합니다. [B. Eye Back]을 바꾸면 Outer Guide도
함께 변경되지만, [ADJUST] 패널에서 S14를 상하로만 이동하면 Outer Guide는 유지된 채 Outer Upper/Lower 곡선의
모양만 변합니다.

• Start Angle: 고정값, 90◦

• Start Curvature: 시작점의 곡률
• End Angle: 고정값, 270◦

• End Curvature: 끝점의 곡률

■ CURVES > Outer Lower (S14-T)

Outer Lower는 헤드의 가장 뒤쪽(시작점 S14)과 테일 끝(끝점 T)을 연결하는 멀티클로소이드 곡선입니다. 시작점
S14에서의 방향은 수직으로 고정되므로, 나머지 세 개의 파라미터만 조절하여 형태를 만듭니다.

• Start Angle: 고정값, 270◦

• Start Curvature: 시작점의 곡률
• End Angle: 끝점의 방향
• End Curvature: 끝점의 곡률

4점 Gb의 위치는 [B. Eye Back] 값에 의해 자동으로 결정됩니다.
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4.1.4 곡선 조정

■ ADJUST > Point Position

앞서 설명한 것처럼 일부 지점의 위치를 이곳에서 조절할 수 있습니다.
단, S14는 Y축을 따라 상하로만 이동하며, S17과 S18은 해당 곡선의 궤적을 따라 움직입니다.

Figure 15: 점 S14,17,18의 위치 조정

• S14 (along the y-Axis): S14를 Y축 방향으로 이동합니다. ’+’는 위로, ’-’는 아래로 조절합니다.
• S17 (along the curve): S17을 Scroll 곡선의 궤적을 따라 이동합니다. ’+’는 위로, ’-’는 아래로 조절합니다.
• S18 (along the curve): S18을 Inner Lower 곡선의 궤적을 따라 이동합니다. ’+’는 위로, ’-’는 아래로 조절합니다.

■ ADJUST > Peg Position

펙홀의 위치는 [I. Upper Peg Margin], [J. Lower Peg Margin], [K:L:M Spacing Ratio] 값을 충족하며, 동시에 Inner

Lower와 Outer Lower 사이의 Center Line상에 놓이도록 자동 계산됩니다.

Figure 16: Center Line과 Peg Hole의 위치
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펙홀 위치 선정 시 가장 주의할 점은 1, 2번 펙(H1, H2)에 감긴 현의 간섭5입니다. 이는 Inner Lower와 Outer Lower

곡선 설계가 까다로운 주요 이유 중 하나입니다. 따라서 설계 단계부터 이 문제를 고려해야 하며, 간섭이 발생하면 두
곡선의 형태를 변경하거나 1, 2번 펙홀(H1, H2)의 위치를 조정해야 합니다.

현의 간섭 여부는 너트에서 각 펙홀 중심까지 직선을 그어 선들이 서로 교차하는지 확인하여 판단할 수 있습니다.
LAYER 패널에서 Peg Interrupt 항목을 활성화하면 해당 선들이 표시되며, 간섭 발생 시 경고 메시지가 나타납니다.

(a)간섭이 없는 경우 (b)간섭이 발생한 경우 (c)간섭 발생시의 경고메세지

Figure 17: 팩홀 위치에 따른 현의 간섭

현의 간섭을 피하려면 펙홀의 위치를 Inner Lower와 Outer Lower 사이의 Center Line 수직 방향으로 조정해야 합
니다. 보통 H1은 앞쪽으로, H2는 뒤쪽으로 이동시킵니다. ’+’ 값을 입력하면 펙홀이 펙박스 뒤쪽으로, ’-’ 값을
입력하면 앞쪽으로 이동합니다. 다만, H2를 뒤로 너무 많이 옮기면 펙에 감긴 현이 펙박스 내벽 후면에 닿을 수 있
으니 주의해야 합니다. 현의 두께 등을 고려하여 펙홀과 내벽 사이의 최소 여유 공간을 미리 계산해 보는 것이 좋습니다.

4개의 현 중에서 4번 펙홀(H4)의 현은 너트 위에서 가장 많이 꺾이며 그 각도가 심할 경우에는 현에 부담을 줄 수 있습니
다. 따라서 간섭이 없더라도 현의 꺾임 각도를 줄이기 위해 위치를 약간 앞쪽으로 조정하는 것도 생각해 볼 수 있습니다.

• 1/2/3/4th Hole: 펙의 이동 거리를 입력합니다. ’+’ 값은 뒤쪽으로, ’-’ 값은 앞쪽으로 이동시킵니다.
• Space (before/after): [K:L:M. Spacing Ratio]에서 설정한 간격 비율이 아닌, 펙 사이의 실제 거리를 보여줍니다.
’before’는 위치 조정 전의 간격이며, ’after’는 위치 조정 후의 최종 간격입니다. before는 항상 설정한 K, L, M

비율을 따르지만, 펙 위치를 조정하면 after의 비율은 달라질 수 있습니다. 실제로 설계에 반영되는 값은 after

이므로, 조정 후 비율이 의도와 크게 다르다면 [K:L:M. Spacing Ratio]를 다시 조절해야 합니다. 다만, 위치
조정은 Center Line의 수직 방향으로 이루어지므로 전후 차이가 크지 않으며 비율도 거의 유지됩니다.

51번 펙(H1)의 현이 펙에 도달하기 전 2번 펙(H2)에 먼저 닿아 꺾이는 현상
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Figure 18: 입력값과 팩의 이동 방향

■ ADJUST > Neck Curve (T-Z)

Neck Curve를 헤드 디자인으로 볼지 넥 디자인으로 볼지는 논란의 여지가 있으나, 본 프로그램에서는 넥 디자인의
일부로 정의합니다. 넥의 가장 얇은 지점(점 Z)의 위치가 결정되어야만 곡선을 작성할 수 있기 때문입니다. 따라서
본 프로그램은 사용자가 점 Z의 위치를 미리 파악하고 있다고 가정합니다.

Neck Curve는 3차 스플라인(Cubic spline)을 사용하여 시작점 T에서 출발해 z3를 거쳐 Z에서 끝납니다. 따라서 T,

Z, z3의 위치에 따라 곡선 모양이 달라집니다. T와 Z는 사용자가 직접 좌표를 입력하지만, z3의 위치는 프로그램이
내부적으로 자동 계산합니다. 점 z1과 z2는 z3를 계산하는 과정에서 생성되는 참고점입니다. 상세한 작성 방법은
Report :: Neck design of stringed instruments6를 참고하시기 바랍니다.

• Start Angle: 시작점 T에서 곡선이 시작되는 방향을 설정합니다.
• Start Strength: 시작점 T에서 곡선이 휘는 강도를 설정합니다. 값이 클수록 T 부근의 곡선이 더 급격하게

굽어집니다.

6https://www.hisviolins.com/post/report-neck-design-of-stringed-instruments
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4.1.5 레이어 설정

■ LAYER

LAYER 패널에서는 [결과 윈도우]와 PDF 파일에 표시하거나 저장할 항목을 선택합니다. 항목들은 그룹별로 들여쓰
기되어 있으며, 체크박스를 선택한 항목만 화면에 나타나거나 저장됩니다. DXF 파일은 체크 여부와 관계없이 모든
데이터가 저장되지만, 선택하지 않은 항목은 ’Layer Off’ 상태로 처리됩니다. 따라서 캐드 프로그램에서 해당 레이어를
켜야만 내용이 보입니다.

• Point/Point Name: 제어점과 참고점, 그리고 각 점의 이름을 각각 독립적으로 표시합니다.
• Scroll, Extended Scroll: Scroll Curve와 Extended Scroll을 각각 독립적으로 표시합니다.
• Inner Guide/Upper/...: Inner Curve의 하위 곡선들을 각각 독립적으로 표시합니다.
• Outer Guide/Upper/...: Outer Curve의 하위 곡선들을 각각 독립적으로 표시합니다.
• Peg Box Guide/Peg...: 펙박스 관련 선들을 각각 독립적으로 표시합니다.
• Neck Line/Neck Curve: 넥 관련 선들을 각각 독립적으로 표시합니다.
• Chin: 턱선을 표시합니다. 턱이 있는 모델에서만 활성화되며 자동으로 선택됩니다.
• Chamfer: 활성화하면 모서리를 가공한 상태를, 비활성화하면 가공 전 상태를 표시합니다.
• Nut: 너트를 표시합니다.
• Cutting Line: 템플릿 제작을 위한 단순 참고용 선입니다.
• Other Guide: 주요 지점을 지나는 수평·수직선을 표시하여 각 부위의 위치 관계를 파악하는 참고선으로 활용

합니다.
• Reference Image: [참고 이미지 설정 윈도우]에서 지정한 이미지를 표시합니다. 이미지를 대조하며 디자인할

때 이 옵션을 활성화해야 합니다.

■ DRAW MODE

[결과 그래프]를 다시 그릴 때 갱신 방법을 선택합니다. (하나만 선택 가능)

• New: 직전에 표시된 결과 그래프를 그대로 두고, 새로운 창을 열어서 표시합니다.
• Redraw: 직전에 표시된 디자인을 지우고, 새로운 디자인을 표시합니다.
• Overlap: 직전에 표시된 디자인을 지우지 않고, 그 위에 새로운 디자인을 함께 표시합니다. 여러 종류의

디자인을 겹쳐서 비교할 때 사용합니다.
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4.1.6 계산과 파일 저장

■ Calculate & Draw

입력한 값을 바탕으로 곡선을 계산하고, 디자인 결과를 화면에 표시합니다.

■ Save to Files

완성된 디자인을 PDF, DXF, TXT 파일로 저장합니다.

파일은 프로그램 실행 파일(Violin_Head_Designer_v.X.X.X.exe)이 있는 폴더에 생성되며,
파일명은 [New_Head_Design_yyyy-mm-dd_hh-mm-ss.XXX] 형식으로 기록됩니다.
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4.1.7 추가 기능

■ File > Import

이전에 저장한 설정 파일을 불러와 동일한 디자인을 즉시 복원할 수 있습니다. [메인 윈도우]에서 [File > Import]를
클릭하여 설정 파일을 불러옵니다. 파일 로드 후 [Calculate & Draw]를 누르면 디자인이 화면에 표시되며, [Save to

Files]를 통해 PDF, DXF, TXT 파일로 출력할 수 있습니다.

■ File > Export

디자인이 완성되면 [메인 윈도우]의 [File > Export] 버튼을 눌러 현재의 모든 설정값을 파일로 저장합니다. 저장된
파일은 나중에 [Import] 기능을 통해 다시 불러올 수 있습니다.

※ 참고 이미지 및 관련 설정값도 모두 설정 파일에 함께 저장됩니다.
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4.2 결과 윈도우

[메인 윈도우]에서 [Calculate & Draw] 버튼을 누르면 나타나는 [결과 윈도우]입니다. 화면에 표시된 모든 내용은 PDF,

DXF, TXT 파일로 동일하게 저장할 수 있습니다. 각 항목의 표시 여부는 [메인 윈도우]의 LAYER 패널에서 설정합니다.

Figure 19: 결과 윈도우

■ 하단 버튼

[결과 윈도우]의 하단에는 이동, 확대/축소 등 여러가지 기능 버튼이 있습니다.
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4.3 참고 이미지 설정 윈도우

악기 사진을 참고하여 디자인하거나 실물을 그대로 따라 그릴 때 사용합니다.

[메인 윈도우] 상단 메뉴의 [Tools>Reference Image]를 클릭하여 실행합니다. 준비한 사진을 불러온 뒤 위치와 크기를
조절할 수 있으며, 악기 치수 측정을 위한 버튼이 있으며 참고선 설정도 가능합니다.

Figure 20: 참고 이미지 설정 윈도우

• Select Image: 참고 이미지를 업로드하는 버튼입니다.
• Height of Image: 화면에 표시될 이미지의 전체 세로 크기를 지정합니다. 실물 크기와 동일한 비율로 작업해야

하므로 실제 사이즈에 가깝게 입력하는 것이 좋습니다. 예를 들어 헤드 길이가 105mm이고 사진의 상하 여백이
각각 20mm라면, 합계인 145를 입력합니다. 나중에 확대/축소 기능으로 정밀하게 조절할 수 있으므로 처음에는
대략적인 값을 입력해도 무방합니다.

• Set Image Origin: 참고 이미지의 원점(0, 0)인 지판 끝단을 지정합니다. 버튼을 클릭하여 마우스 커서가 바뀌면,
원하는 지점을 선택해 원점으로 설정할 수 있습니다.

• Horizon Line-1/2/3: 높이 참조를 위한 수평 참고선입니다. 체크박스를 활성화하고 값을 입력하면 해당 위치에
수평선이 나타납니다.

• Vertical Line-1/2/3: 너비 참조를 위한 수직 참고선입니다. 체크박스를 활성화하고 값을 입력하면 해당 위치에
수직선이 나타납니다.

• Angle Line-1: 첼로와 비올라의 턱 기울기를 참조하기 위한 사선입니다. 체크박스를 활성화하고 값을 입력하면
원점을 지나는 사선이 표시됩니다.

• Move (y-Axis): 사선 참고선을 Y축 방향으로 이동시킵니다.
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• Move/Rotate/Zoom Image: 참고 이미지를 이동, 회전하거나 확대/축소합니다.
• Measuring ∆X: 참고 이미지 내 두 지점 사이의 X축 거리를 측정합니다. 버튼 클릭 후 마우스 커서가 바뀌면,

두 지점을 선택하여 거리를 확인할 수 있습니다.
• Measuring ∆Y : 참고 이미지 내 두 지점 사이의 Y축 거리를 측정합니다. 사용법은 X축 거리 측정과 동일합니다.
• Measuring ∆D: 참고 이미지 내 두 지점 사이의 직선 거리를 측정합니다. 사용법은 X축 거리 측정과 동일합

니다.
• Draw Image: [참고 이미지 결과 윈도우]를 화면에 표시합니다.
• Reset Image: 이동, 회전, 확대/축소된 참고 이미지를 초기 상태로 되돌립니다.
• Clear All: 이미지를 포함한 모든 설정값을 삭제합니다.
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4.4 참고 이미지 결과 윈도우

[참고 이미지 설정 윈도우]에서 이미지를 불러온 뒤 [Draw Image] 버튼을 클릭하면 나타나는 화면입니다. 이 창을
통해 이미지의 위치와 크기를 실시간으로 조정할 수 있습니다. 설정 윈도우에서 참고선을 활성화하면 해당 위치에
선이 표시됩니다. 참고 이미지는 작업 편의를 위해 원본이 컬러인 경우에도 항상 흑백으로 전환되어 표시됩니다.

이미지를 확대하거나 이동하며 세밀하게 작업할 때는 결과 윈도우 하단의 조작 버튼을 활용하면 더욱 편리합니다.

Figure 21: 참고 이미지 결과 윈도우

H.I.S. Violin Atelier, Manual, April 2026 Page 31 of 34



Violin Head Designer, v.1.0.0 User Manual

4.5 포인트 가이드 윈도우

프로그램에서 사용하는 주요 지점들의 위치를 한눈에 확인할 수 있는 가이드 이미지입니다. [메인 윈도우] 상단 메뉴의
[Tools>Point Guide]를 클릭하면 나타납니다.

Figure 22: 포인트 가이드 윈도우
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5 실제 사용 방법과 순서

기존 바이올린 헤드를 정교하게 카피하는 실제 작업 순서를 설명합니다. 모델을 변형하거나 새로운 디자인을 제작할
때도 이 과정을 바탕으로 진행하면 편리합니다.

전체적인 작업 방법과 순서는 다음과 같습니다.

1. 시작
프로그램을 실행한 후 [메인 윈도우]에서 모델명 입력 > 프리셋 선택 > Tools > Reference Image를 차례로 클릭
합니다.

2. 참고 이미지 업로드
[참고 이미지 설정 윈도우]에서 이미지를 불러온 뒤, 이미지 사이즈를 입력하고 [Draw Image] 버튼을 클릭합니다.

3. 참고 이미지 조정
이미지 기울기와 축척을 조절하고 원점을 설정합니다. 필요한 경우 각 부분의 거리를 측정하고 설정 창을
닫습니다.

4. 곡선 설정과 결과 확인
[메인 윈도우]에서 [Calculate & Draw] 버튼을 클릭합니다. 표시되는 결과 화면을 확인하며 GEOMETRY,

CURVES, ADJUST의 입력값을 수정합니다.

5. 파일 저장
[Save to Files] 버튼을 눌러 디자인 결과물을 저장하고, [File > Export]를 통해 현재의 설정값 파일을 별도로
저장합니다.
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6 개발 환경과 사용 환경

본 소프트웨어는 《Windows OS 용》이며, 《Python 3.10 + Tkinter》 환경에서 개발하고 《Windows 11》에서만 동작
확인되었습니다.

참고 사이트
H.I.S. Violin Atelier – https://www.hisviolins.com

Copyright © 2026 Hwang, Il-Seok. All rights reserved.
Unauthorized modification and commercial sale are prohibited.
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